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Insindoritydn aiheena oli tutkia 3D-mallin optimointia. Tarkoituksena oli tuottaa prosessi, jolla
pystytdan tuottamaan kevytta, mutta tarkkaa, 3D-mallia. Tata tutkittin Espoon Karamalmilta
havainnoidulla aineistolla.

Aineisto kerattiin ilmakuvaamalla alue Camflight FX8 -kopterilla, johon oli kiinnitetty Sony
Alpha 7r -kamera. Taman jalkeen yksityiskohtaisimmat alueet laserkeilattiin. Molemmista
aineistoista kasiteltiin erilliset pistepilvet, jotka luokiteltiin. Saatuja luokitteluja kasiteltiin
CloudCompare-ohjelmalla siten, etta tasaisemmilta alueilta vahennettiin pisteita ja yksityis-
kohtaisemmille alueille jatettiin suhteessa enemman pisteitd. Nain ollen valmiista mallista
pyrittiin tekemaan kevyempi ja nopeampi kayttaa, sailyttaen resoluution mahdollisimman hy-
vana.

Prosessin avulla voidaan korjata esimerkiksi ilmakuvauksessa tulevia katvealueita. Havain-
tojen perusteella huomattiin, ettd on mahdollista luoda toimiva prosessi, jolla mallin element-
teja keskitetdan yksityiskohtaisemmille alueille ja vahennetaan tasaisemmilta alueilta.
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The purpose of this final year project was to examine 3D-model optimizing. The data which
was used in the optimizing process was acquired from Karamalmi, Espoo.

The methods for acquiring data were aerial photography and laser scanning. Aerial photos
were processed into a point cloud with the Agisoft Photoscan software, whereas laser scan-
ning generated a point cloud more suitable for optimizing at once. Aerial photos were taken
with a Sony Alpha 7r camera which was mounted into a remotely piloted aircraft Camlight
FX8. The laser scans were performed with a Leica P30 laser scanner.

The point clouds were classified in the Terrasolid Terrascan -software separately and com-
bined as a single point cloud in the Cloud Compare software. The optimizing process itself
was done by removing points from flat surfaces and maintaining points on the curved areas.
The study concluded that the triangulated model became lighter and more usable without
significantly reducing the resolution.

The process introduced in this Bachelor’s thesis can be applied to update and upgrade ex-
isting 3D-models.

Keywords 3D-model, laser scanning, aerial photogrammetry
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Lyhenteet

CAD Computer Aided Design. Tietokone avusteinen suunnittelu.

CC CloudCompare. Pistepilvien kasittelyohjelma.

LOD Level Of Details. 3D-mallin luokittelumetodi.

RPAS Remotely Piloted Aircraft System. Kauko-ohjattu ilma-alusjarjestelma.
RTK Real Time Kinematic. Satelliittimittausmenetelma, jossa kaytetdan vahin-

taan kahta satelliittivastaanotinta, joista toinen sijaitsee tunnetulla pisteella

ja toisella kartoitetaan halutut kohteet reaaliajassa.

VRS Virtual Reference System. Virtuaalinen tukiasema.
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1 Johdanto

1.1 Esittely

Taman insinddritydn tarkoitus on esitelld toimintatapa, miten eri mittausmenetelmia
voidaan hyddyntaa kevyen, mutta resoluutioltaan tarkan 3D-mallin muodostamisessa.
Menetelma sopii erityisesti visualisointimalleihin, mutta se on myos mittatarkka.
Kokonaisuuden hahmottamisen kannalta on hyva mallintaa laajempi alue, mutta sen ei
tarvitse olla yhtd tarkka kaikkialta. Kaikissa havainnointimenetelmissd on hyvia ja

huonoja puolia, joten menetelman valinta taytyy suorittaa kohteen mukaan.

Nykyaan tietomallien vallatessa erityisesti rakennusalaa, pohja-aineiston tarve kasvaa
jatkuvasti. Perinteisilla menetelmilla, kuten maastomalli VRS—RTK:lla tai takymetrilla, ei
pystyta tuottamaan aineistoa samalla tahdilla kuin iimakuvauksella tai laserkeilauksella.
Pistemaaran kasvu pakottaa uudistumaan my0ds kasittelypuolella. Sielld perinteiset
CAD-ohjelmistot eivat tietorakenteesta johtuen kykene kasittelemaan monia miljoonia
pisteita kerrallaan, vaan tarvitaan kehittyneempia ohjelmia. Muutos on lahtenyt liikkeelle

vasta viime vuosien aikana kalustojen ja ohjelmistojen hintojen tullessa edullisemmiksi.

Lisdhaasteena tulevaisuudessa on kired aikataulu ja kustannukset. Nopeaan mallin
tuottoon tarvitaan selkead prosessi, jolla mallia voidaan paivittda vain niiltd osin, kun sita
tarvitaan. Esimerkiksi Helsingin kaupungin kaupunkimalli on toteutettu noin 50 000
pysty- ja viistokuvasta. [1] Kuvauksen suorittaminen uudestaan on tydlas ja kallis
prosessi verrattuna siihen, ettd mallia paivitetddn vain osissa. Toisaalta suuren mallin
paivittdminen vaatii myds tarkan listauksen siita, mita pisteitd mallista on paivitetty, mutta
tassa tydssa esitelty menetelma ottaa kantaa vain itse mittausprosessiin ja pisteiden

kasittelyyn.

1.2 Hypoteesi

Ongelmaa lahdettiin pohtimaan olettamuksen eli hypoteesin kautta, joka esitetaan
kuvassa 1. Perusidea on tutkia ilmasta ja maasta suoritettavien havainnointimenetelmien
yhdistamista yhdeksi kevyeksi malliksi. Tarkoituksena on tuottaa malli, jossa haluttuja

kohteita on tarkennettu resoluution osalta erityyppisilla havainnointimenetelmilla.



Prosessin kayttdkohteita voisivat olla muun muassa arkkitehtuuriset suunnitelmat,

kaupunkimallit ja tietomallien pohja-aineistot.

Pohjaksi otettiin ilmakuvausaineisto, josta prosessoidaan pistepilvi fotogrammetrian
avulla. llmakuvauksella saadaan laajoja alueita suhteellisen nopeasti riittavalla laadulla.
Kuvauksessa saaduille pisteille tulee myds RGB-arvo, jolloin teksturoidun mallin
tuottaminen tasta aineistosta onnistuu helposti. Kuitenkaan eri menetelmien RGB-arvot
eivat tule olemaan yhtenaiset, jolloin ennen lopullista kolmiointia prosessoidaan variarvot

kaikille pisteille kayttaen kokoalueen ortokuvaa.

Kerataan . Kasitellaan aineistoa ja
N Prosessoidaan

aineisto . o maaritetaan tarkennettavat
. fotopistepilvi

ilmasta alueet

Kolmioidaan
Kerataan Luokitellaan yhdistetty malli ja

tarkennus pistepilvet ja teksturoidana
aineistot yhdistetaan ne tarvittaessa
uudelleen

Kevyt ja tarkka
3D-malli

Kuva 1. Hypoteesi.



2 Havainnointitekniikat

Taman insindoritydn pistepilviaineistot tuotettin RPAS-laitteella otetuista ilmakuvista
sekd maalaserkeilaamaalla. Tydssa ei ollut mahdollisuutta tuottaa pistepilviaineistoa
muilla tavoilla, joten kaksi edelld mainittua valikoituivat aineistonkeruumenetelmiksi.
Muut mahdolliset menetelmat, joilla voidaan tuottaa pistepilvida 3D-mallia varten, on

esitelty paapiirteittain.

Menetelmat, joilla pistepilviaineistoja voidaan kerata, jaettiin kahteen kategoriaan niiden
kayttdtarkoitusten mukaan tassa insinddritydssd. Kaytettavat kategoriat ovat pohja-
aineisto, josta 3D-malli padosin tuotetaan, sekd tarkennusaineisto, jolla joko
tarkennetaan pohja-aineiston puutteita (kuopat, huono aineisto jne.), korostetaan
haluttuja kohteita (rakennusten edustat, rappuset, monimutkaiset kohteet) tai tuotetaan
pistepilviaineistoa sellaisista kohteista, joita ei pohja-aineistonkeruumenetelmilla saada

tuotettua.

2.1 Pohja-aineistot

2.1.1 llmakuvaus

llmakuvaus on passiivista kaukokartoitusta, jossa mitataan kohteen heijastamaa
auringonvalon sateilya. Ulkoinen valonlahde, auringonvalo, heijastuu kartoitettavasta
kohteesta, jonka kamera ftaltioi. Ilmakuvaus voidaan suorittaa lentokoneella,
helikopterilla, miehittamattdmalla ilma-aluksella tai satelliitila. Tavallisimmin
satelliittikuvat ovat 500—1000 metrin korkeudesta otettuja. Lentokoneella ja helikopterilla
suoritetun ilmakuvauksen lentokorkeus on 500-10 000 metrid. Trafin maarayksen
mukaan [2] RPAS-laitteen suurin sallittu lentokorkeus on 150 m. Pistepilven resoluutio
riippuu maastopikselin koosta, joka yleensa on pienempi mitd matalammalta kuvat on
otettu. Kuvaukset suoritetaan kuvausjonoina siten, ettd perakkaisilla kuvilla on suuri
pituuspeitto (n. 70 %) ja vierekkaisilla kuvilla n. 70 %:n sivuttaispeitto. Kuvat voidaan

luokitella kallistuksen mukaan pysty- ja viistokuviin.

llImakuvilla pystytaan hankkimaan dataa laajalta alueelta nopeasti. Lentokoneilla tai
koptereilla pystytddan kuvaamaan useita kymmenia nelidkilometreja lyhyessa ajassa.

RPAS-laitteilla on laitteistosta riippuen mahdollista kuvata useita hehtaareita yhdella



lentosuunnitelmalla. RPAS-laitteilla suoritettavien ilmakuvausten etu tavallisiin
miehitetyilld iima-aluksilla suoritettaviin ilmakuvauksiin on sen edullisuus. RPAS-laitteen
hankkiminen ja operoiminen maksaa vain murto-osan verrattuna miehitetyilld ilma-
aluksilla operoimiseen. Laitevalmistajat ovat viime vuosina tuoneet markkinoille entista

kayttovalmiimpia laitepaketteja, jolloin laitteiden kayttd on helpottunut.

limakuvista prosessoidun fotopistepilven heikkous on, ettei sen resoluutio ole yhta suuri
kuin laserkeilatun pistepilven. Maastopikselin koko vaikuttaa siihen, miten tarkasti
valokuvista prosessoidaan pistepilvi, joten yksityiskohtaisemmat kohteet, kuten
katukiveykset, eivat erotu ilmakuvista prosessoidusta fotopistepilvesta yhta selkeasti
kuin maalaserkeilatusta pistepilvesta. Oikean maanpinnan tulkitseminen ilmakuvista on
haasteellista alueilla, joissa on matalaa kasvillisuutta, silla pistepilvi muodostuu kuvassa
nakyvien kohteiden mukaan. limakuvaus vaatii onnistuakseen tasaiset sagolosuhteet ja
valoisuuden. Isot kontrastit aikaansaavat prosessoinnissa kohinaa jota pystytaan

jalkikasittelyssa korjaamaan. limasta kasin ei saada kuvattua peitteellisia kohteita. [3]

2.1.1.1 Pystykuvaus

Valokuva otetaan teoreettisesti kohtisuoraan alaspain kuvakallistuksen ollessa alle 5
astetta. Kuvakallistuksen ollessa 0 astetta on kyseessa nadiirikuvaus. Pystykuvista on
hankala erottaa rakennusten julkisivuja, siltojen alla olevia osia seka isojen puiden alla

olevaa maastoa. [3; 4; 5; 6.]

2.1.1.2 Viistokuvaus

Matalassa viistokuvauksessa kuvauskulma on alle 45 astetta, ja valokuvassa horisontti
rajautuu kuvan ulkopuolelle. Viistokuvissa kuvien resoluutio on paras valokuvassa
lahimpana olevilla kohteilla, ja se muuttuu huonommaksi, mitd kauempana kuvaa
kohteet ovat. Viistokuvilla saadaan kuvattua rakennusten julkisivut seka nahdaan
sellaisten kohteiden alle, joita ei pystykuvista ndy. Viistokuvat vaativat lentosuunnitelman
teossa huolellisempaa suunnittelua kuin pystykuvat. Viistokuvausta suunniteltaessa
tulee ottaa huomioon mahdolliset peitteet, joita aiheutuu korkeista puista tai
rakennuksista. Lentolinjojen sijaintia, lentokorkeutta tai kuvauskulmaa muuttamalla
voidaan varmistaa haluttujen kohteiden nakyminen kuvassa. Korkeassa

viistokuvauksessa kuvauskulma on yli 45 astetta, ja valokuvassa horisontti nakyy



kuvassa. Tama soveltuu laajojen alueiden visuaaliseen esitykseen paremmin kuin

kartoitukseen tai fotopistepilven luomiseen. [3; 4; 5; 6.]



2.1.2 llmalaserkeilaus

limalaserkeilausta voidaan suorittaa lentokoneella tai RPAS-laitteella.
Iimalaserkeilauksella saadaan havainnoitua maanpintaa kasvillisuuden peittamilta
alueilta ilmakuvia paremmin. Menetelmalld saadaan aineistoa laajalta alueelta.
Laserkeilaus ei ole riippuvainen ulkoisesta valonlahteesta, joten pistepilveen ei tule
esimerkiksi varjojen tai kirkkaiden pintojen aiheuttamaa kohinaa. Aineistosta voidaan

tulkita maanpinta ja rakennusten katot.

Rakennusten julkisivuja seka yksityiskohtaisempia kohteita pistepilvesta ei voida erottaa.
limalaserkeilausjarjestelmat ovat isoja investointeja, joten niiden hankkiminen vaatii

resursseja.

2.2 Tarkennusaineistot

2.2.1 Staattinen keilaus

Kolmijalan paaltd suoritettavaa laserkeilausta voidaan kayttda sellaisten kohteiden
kartoittamiseen, joita ei ilmasta kasin esimerkiksi peitteellisyyden vuoksi voida havaita.
Maalaserkeilaimella tuotettua korkean resoluution tiheda pistepilved voidaan kayttaa
yksityiskohtaisempien kohteiden mallintamiseen. Maalasekeilauksella pystytdan
kartoittamaan rakennusten julkisivut ja pistepilven pisteille saadaan RGB-arvo, kun
skannausten yhteydessa otetaan myds varivalokuvat. Nain rakennusten julkisivuille
voidaan tuottaa tekstuurit. Maalaserkeilauksen hyvid puolia ovat suuri resoluutio ja

monipuoliset kayttokohteet.

Menetelman heikkous on sen tuotantonopeuden hitaus. Suurten alueiden osalta datan
kerddminen laserkeilaamalla kolmijalan paaltd on hitaampaa kuin mobiilisti
laserkeilaamalla tai ilmakuvaamalla. Teknologian kehittyessa mittalaitteiden hinnat ovat
laskussa; tarkkojen laserkeilainten hinnat ovat silti melko korkeita, mika tekee

laadukkaasta laserkeilaimesta merkittavan investoinnin.



2.2.2 Mobiilikeilaus (auto, reppu, monkija, moottorikelkka)

Mobiilikeilausta voidaan hyodyntaa liikkennevaylien tai rakentamattomien alueiden
kartoituksessa. Mobiililaserkeilausta voidaan suorittaa joko autoon, monkijaan tai
moottorikelkkaan asennetulla laserkeilausjarjestelmalld tai seldssd kannettavalla
reppukeilaimella. Autoon asennettavalla laserkeilaimella saadaan laajoja tiealueita, seka
teiden 1ahiymparistda kartoitettua nopeasti. Ménkijaan tai moottorikelkkaan asennetulla

jarjestelmalld on mahdollista kartoittaa rakentamattomia alueita, johon ei autolla paase.

Reppukeilaimella voidaan skannata sellaisia alueita, jonne ei autolla, monkijalla tai
moottorikelkalla voi ajaa tai jotka eivat ole ilmasta havaittavissa.
Mobiilikeilausmenetelmilld tuotetuista aineistoista voidaan havaita esimerkiksi

reunakivilinjat selkeasti.

2.2.3 Autofotopistepilvi

Fotogrammetrian keinoin tuotettua pistepilved voidaan tuottaa esimerkiksi autoon tai
kiskoilla kulkevaan vaunuun asennettavalla kuvausjarjestelmalla. Sita voidaan kayttaa

samankaltaisissa kohteissa kuin mobiililaserkeilainta. [7]

2.2.4 Takymetri

Maastomallia voidaan kartoittaa myos takymetrilla, jolloin pisteitd tulee huomattavasti
harvemmin kuin edelld mainituilla tekniikoilla. Takymetrilla kartoittaminen vie
huomattavasti enemman aikaa kuin edelld mainituilla mittaustavoilla. Takymetrilla
mitattujen maastomallipisteiden kasittely ei vaadi tietokoneelta juurikaan laskentatehoa

toisin kuin isojen pistepilviaineistojen kasittely.

2.3 Referenssiaineistot

Pistepilvien rekisterdintia varten mitattujen tahysten ja signaaliristien mitattuja
koordinaatteja voidaan verrata pistepilvistd erotettaviin kohteisiin. Kontrollipisteina
voidaan kayttaa esimerkiksi valokuvilta nahtavia suojatiemaalauksia, reunakivilinjoja tai

kaivonkansia, jotka mitataan joko takymetri- tai satelliittimittauksella.



2.3.1 Kansallisesti saatavilla oleva aineisto

Maanmittauslaitoksen (MML) laserkeilausaineisto on suunnattu yleiseen kayttéon
esimerkiksi maastomallien rakentamiseen. Tarkkaan 3D-mallin tydstoon aineisto ei sovi,
koska pisteiden etaisyys toisistaan on keskimaarin noin 1,2 m, pistetiheys 0,5 pts/m? ja
tarkkuus tasossa enintddn 60 cm ja korkeudessa 15 cm. Toisaalta aineisto soveltuu
hyvin esimerkiksi tédssa insinooritydssa esitellyn prosessin pohja-aineistoksi, mikali
huomioidaan, ettd se on vain Vvisualisointikdyttéén. MML:n tarjoamassa
laserpistepilviaineistossa pisteilld ei ole variarvoa, joten siitd ei pysty ilman kasittelya
muodostamaan teksturoitua mallia. Pistepilviaineistoon voi yhdistaa varit esimerkiksi

saman organisaation kuvaamista ilmakuvista. [8]

2.3.2 Kaupunkien aineistot karttapalveluissa

Helsinki Region Infoshare (HRI) -palvelu on Helsingin, Espoon, Vantaan ja Kauniaisten
kaupunkien yhteinen avoimen datan palvelu. Palvelusta 10ytyy paakaupunkiseudun
kaupunkeja ja koko seutua koskevaa tietoa, joka on kaikkien hydédynnettavissa maksutta

ja vapaasti.

Saatavilla on Helsingin kaupungin laserkeilausaineistoa LAZ-muodossa. Koko aineiston
pistetiheys on 20.0 pts/m? ja maanpintaa kuvaavan aineiston pistetiheys 0,279-0,340
pts/m2. Muiden kaupunkien tuottamaa laserkeilausaineistoa ei tyon kirjoitushetkella ole

HRI:n palvelusta iimaiseksi saatavilla.

Helsingin kaupunki tarjpaa ainoana kokonaista kaupunkimallia. Kaupunkimalli on
CityMGL-standardissa, ja se sisaltaa teksturoidut rakennukset enintddn LOD2-luokassa
ominaisuustietoineen. Lisaksi Helsingistd on saatavilla ortokuvia, joista tuorein on
vuodelta 2017.

Espoon kaupunki tarjoaa rakennusten 3D-mallit tarkkuustasolla LOD1 SKP-formaatissa,
joka on SketchUp-ohjelmalla aukeava tiedostoformaatti. Rakennuksilla ei ole tekstuuria.

Espoon kaupunki tarjoaa myds ortokuvan, joista tuorein on vuodelta 2015.

Vantaan kaupunki on tuottanut rakennusten 3D-mallit tarkkuusluokissa LOD1 seka

LOD2. Tiedostoformaatit, joissa aineisto on saatavilla, ovat CityGML, SKP sekad KML.



Aineistoon on lisatty ilmakuvista katto- seka seinatekstuurit. Tuorein ilmakuvaus, josta

Vantaan kaupunki tarjoaa ortokuvan, on vuodelta 2015.

Aineistojen  hyodyntadmisessa tulee ottaa huomioon sen julkaisu- seka
paivitysajankohtaa. Jotkut HRI:n aineistot paivittyvat lahes viikoittain, kun taas toiset

kerran vuoteen tai harvemmin. [9]
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3 Ohjelmistot

3.1 Ohjelmistojen esittely

3.1.1 Yleista

Tybssa kaytettiin erilaisia ohjelmistoja sekd suunnittelu- etta koetydvaiheessa. Projektin
edetessa huomattiin, ettei tarjolla ole montaa sopivaa ohjelmistoa. Yksi syy saattaa olla
se, ettd ohjelmistojen tietorakenne on alun perin suunniteltu kasittelemaan vain muuta-
mia kymmenia tai satoja pisteitd, kun nykyaan vaatimukset ovat sadoissa miljoonissa.
Ominaisuuksia yritetaan laajentaa lisdosilla, mutta lopputulos ei ole aina paras mahdol-
linen. Ominaisuuksien maaran kasvaessa myds yhteensopivuusongelmat lisdantyvat ja

ohjelmistoista tulee todella raskaita.

Ohjelmistoiksi valittiin paaosin pienten toimijoiden kehittamia seka joitakin avoimen lah-
dekoodin sovelluksia. Metropolian hankinnat aiheuttivat jonkin verran rajoitteita ohjelmis-
tojen valinnalle, mutta se ei ollut suuri tekija taman koetyon teossa. Keskeisiin sovelluk-
siin oli jo lisenssi. Valintaa ohjasi myos vapaasti saatavilla olevan ohjeistuksen maara.
Ohjelmaa oli helpompi opiskella, jos saatavilla on selkeita ja kattavia opetusvideoita ja

dokumentteja. Seuraavaksi koetydssa kaytettavien ohjelmistojen esittely.

3.1.2 Agisoft Photoscan

Agisoft on venalainen ohjelmistoyritys, joka on perustettu vuonna 2006. Yritys mainitsee
internetsivuillaan paadmaarakseen kehittda pienen budjetin sovelluksia teollisuuden ja ta-

vallisten ihmisten kayttdéon. [10]

Yrityksen paatuote on Photoscan-niminen kuvaprosessointiohjelmisto. Ohjelman paa-
tehtava on prosessoida sille sybtettavasta valokuva-aineistosta pistepilvi, johon on kehi-
tetty hyvat tyokalut. Kayttajalle on annettu mahdollisuus muokata laajasti erilaisia las-
kentaparametreja ja kasitelld aineistoa eri ndkymissa. Aineistoa voi myods luokitella ja

kolmioida. Photoscan tukee yleisesti tunnettuja ja kaytettyja formaatteja laajasti.

Ohjelmistoa kehitetdan aktiivisesti, ja tdmankin insinddritydprosessin aikana ilmestyi
kaksi uutta versiota. Photoscanin dokumentaatio on selkeaa, ja sen lisaksi yrityksen in-

ternetsivuilla on sopivasti esimerkkeja seka tutoriaaleja ohjelman kaytosta. Ne auttoivat
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suuresti myos taman tyon tekemisessa. Lisaksi aktiivinen kayttajakunta keskustelee oh-
jelmaa varten perustetulla keskustelualustalla. Sité selatessa huomaa myds yrityksen

edustajien vastaavan saannollisesti kayttajien kysymyksiin.

3.1.3 CloudCompare (CC)

CloudCompare on avoimen ldhdekoodin 3D-pistepilvien kasittelyohjelmisto, jota kehite-
tdadn nykyaan yhteisdn voimin vapaassa ohjelmistojen versionhallintaymparistd GitHu-
bissa. Ohjelmiston kehitysprojekti kdynnistettiin aikoinaan Pariisissa Telecomin ja EDF:n
(Electricité de France) yhteistyéna. Vuodesta 2003 Daniel Girardeau-Montaut on ollut

projektin paaasiallinen vetaja. [11]

CloudComparea kaytetaan laajasti ympari maailmaa, joten sen kehitys on ollut nopeaa.
Ohjelmaan on rakennettu paljon erilaisia laskenta-algoritmeja, joita voidaan kayttaa ai-
neistojen prosessointiin. CloudCompare on alun perin kehitetty vertailemaan kahta pis-
tepilvea tai niista kolmioituja malleja. Tasta johtuen se pystyy kasittelemaan raskaitakin
pistepilviaineistoja sujuvasti riippuen saatavilla olevasta laskentatehosta. Ensivaikutel-
masta l&htien ohjelman kayttod oli vakaata. Erilaisilla lisdkirjastoilla ohjelmaa pystyy laa-

jentamaan monipuolisesti.

Virallista dokumentaatiota tarjotaan omalla wiki-alustalla, ja sinne on keratty tietoa kai-
kista ohjelman toiminnoista pois lukien joidenkin lisdosakirjastojen ohjeistukset. Nykyi-
nen yllapitaja vastaa muutamassa paivassa keskustelualueelle lahetettyihin kysymyk-

siin. Lisdosille 16ytyy omaa dokumentaatiota niiden kehittdjien omilta internetsivuilta.

3.1.4 Leica Cyclone

Leica Cyclone on sveitsilaisen Leican kehittdma erityisesti laserkeilausaineiston kasitte-
lyohjelmisto [12]. Ohjelmiston paatarkoitus on helpottaa Leican omilla laserkeilaimilla
(esim. Leica P30) havainnoidun aineiston kasittelyd. Cyclone on nykyaan maailmalla

laajasti kaytetty pistepilvien kasittelyohjelmisto.

Ohjelma on kehitetty CloudComparen tavoin kasittelemaan 3D-pistepilvia. Kun aineisto
tuodaan ohjelmaan, se tallennetaan omaan tietokantaan, joka voi sijaita esimerkiksi ul-

koisella kovalevylla tai verkkoasemalla Cyclone Server -ohjelmiston avulla. [13]
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Keilaimelta tallennettua aineistoa on mahdollista rekisterdida ensiksi monipuolisilla tyo-
kaluilla ja sen jalkeen kasitelld lukuisilla eri toiminnoilla. Tarjolla on muun muassa puoli-
automaattinen rekisterdintityokalu, joka mahdollistaa eri kojeasemien pisteiden yhdista-
misen ja esikasittelyn. Pisteiden kasittelya voidaan tehda helposti limit box -tydkalun
avulla, jolla voi rajata kasittelyaluetta. Mallinnukseen Cyclonessa on valmiina automa-
tiikkaa, joka etsii pisteiden valisista suhteista erilaisia geometrisia muotoja. Tuotekuvien
perusteella Cyclonea mainostetaan monimutkaisten teollisuuslaitosten mallinnukseen

sopivaksi, mutta ohjelmalla pystyy tekemaan myos laajoja inframalleja.

3.1.5 Terrasolid-ohjelmisto

Terrasolid-ohjelmisto on suomalaisen Terrasolid-yrityksen kehittdma sovellusperhe, joka
tarjoaa tyokaluja pistepilvien kasittelyyn. Yritys on perustettu vuonna 1989, jolloin laser-
keilaus oli vasta alkanut kehittya. Nykyaan yrityksella on noin kymmenen tyontekijaa, ja

sen tuotteita kaytetdan noin 100 eri maassa. [14]

Terrasolidin paatuotteita ovat Terrascan (laserkeilausaineiston kasittely), TerraMatch
(lentolinjojen sovitus), TerraModeler (kolmiointi) ja TerraPhoto (kuvien kasittely). Ku-
vassa 2 nakyy minkalaisiin toimintoihin yhtion tarjoamat tuotteet sopivat. Muun muassa
naiden palveluiden avulla yhtid on maailman johtava ohjelmistojen tuottaja omalla liike-

toiminta-alueellaan.
Ohjelmat vaativat toimiakseen Benleyn kehittdman Microstation CAD -suunnitteluohjel-

miston, jossa ne pyorivat lisdosina varsinaisen ohjelman paalla. Néama yhdessa luovat

tehokkaan paketin kaikenlaiseen mallintamiseen.

forest inventory

power line . .
mapping 7Terraso||d tunnel scanning
pipeline corridor LiDAR / Imagery railway &
planning airborne terrestrial tram survey
mobile
flood _ Digital \ highway &
risk _Elevatlon Models Software for LIDAR Processing road survey
mappin .
PPINg volume contour lines 3D city models
calculation

noise propagation

change detection & .
analysis

damage assessment

Kuva 2. Terrasolid-ohjelmistot [15].
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3.2 Pistepilviformaatit

3.2.1 Yleista

Maanmittaustekniikassa formaatit voidaan jakaa karkeasti sisdisesti kaytettaviin ja siir-
toformaatteihin. Naiden kahden ero on siina, etta siirtoformaatit ovat yleisesti sovittuja
tai kansainvalisid standardeja, jolloin yhteensopivuus eri ohjelmistojen valilla on hyva.
Sisaisiin formaatteihin kuuluvat ohjelmien tietorakenteessa kaytettavat formaatit. Tehok-
kaan ja sujuvan kayton takaamiseksi siirtoformaatti kdannetaan sisdanlukuprosessissa

sisdiseen formaattiin.

Toinen karkea jaottelu voidaan tehda formaatin muodon avulla eli tallennetaanko for-
maattiin tietoa binaari- vai tekstimuotoisena. Suurissa aineistoissa kaytetaan binaari-
muotoa, koska se on nopeampaa lukea ja kirjoittaa. Tekstimuodossa ohjelmisto suorittaa

aina kdannosprosessin, mika hidastaa lukemista. [16]

3.2.2 Siirtoformaatteja

LAS / LAZ

LAS on American Society for Photogrammetry and Remote Sensing (ASPRS) -organi-
saation alkujaan kehittama, laajasti kaytetty pistepilviformaatti. 3D-aineistojen siirtoon
tarkoitettu formaatti kykenee tallentamaan myds erilaisia attribuutteja formaattiversiosta
riippuen. LAS kehitettiin vastaamaan tarpeeseen, jossa eri valmistajien ohjelmistot ja
formaatit eivat keskustelleen keskenaan. Lisaksi tekstimuotoiset formaatit hidastuvat
merkittavasti suuria pistepilvia kasitellessa, ja niiden tiedostokoko kasvaa. LAS-formaat-
tia tukevat nykyaan kaikki modernit pistepilven kasittelyohjelmistot, silla se on onnistunut

tekemaan tietorakenteesta selkean. LAZ on pakattu versio LAS-formaatista. [17]

E57

American Society for Testing and Materials (ASTM) standardisoima siirtoformaatti, joka
yhdistelee binaari- sekd xml-muotoista dataa. Formaatin on kehittdnyt ASTM:n yksi si-
saisista komiteoista nimelta Data Interoperability, joka tarkoittaa tietojen yhteensopi-
vuutta. Avoimen lahdekoodin toteutus ASTM E57 -standardista nimelta LibE57.org ker-

too verkkosivuillaan E57- ja LAS-formaattien erosta. [18] Sivuston mukaan LAS-
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formaatti on kehitetty palvelemaan ensisijaisesti LIDAR-aineistoja ja kaikenlaista havain-
nointia ilmasta. E57 taas pyrkii olemaan yleisformaatti, jota pystyy skaalaamaan helposti
eri tarpeisiin, mutta silti samat keskeiset tietorakenteet sailyvat. [19] LibE57-yhteiso listaa
myds useita ohjelmia, joihin on rakennettu formaatin natiivituki. Natiivituki tarkoittaa
tassa yhteydessa sita, ettd ohjelman koodiin on sisdanrakennettu tarkasteltavalle for-
maatille. Muun muassa tassa tutkimuksessa kaytettdvat CloudCompare ja Leica Cy-

clone tukevat E57-formaattia.

<?xml version="1.0" encoding="UTF-8"7?>
<e57Root type="Structure" xmlns="http://www.astm.org/COMMIT/E57/2010-
eb7-v1.0">
<formatName type="String"><![CDATA[ASTM E57 3D Imaging Data
File]]></formatName>
<guid type="String"><![CDATA[{56D8F874-3656-4CA8-BAl7-
8BF9757063D0}]]1></guid>
<versionMajor type="Integer">1</versionMajor>
<versionMinor type="Integer"/>
<eb7LibraryVersion type="String"><![CDATA[InteliSum-LD3-Studio-V5.1-
E57RefImpl-0.3.173-x86-windows]]></e57LibraryVersion>
<coordinateMetadata type="String"/>
<creationDateTime type="Structure">
<dateTimeValue type="Float">9.6758299097398019e+008</dateTime-
Value>
<isAtomicClockReferenced type="Integer"/>

</creationDateTime>
\

\
\

\

</e57Root>
Esimerkkikoodi 1. E57-formaatin XML-koodi [20].

XYZ

XYZ on maanmittaustekniikassa yleisesti kaytetty formaattimuoto. Tasta formaatista on
olemassa paljon erilaisia variaatioita, mutta perinteisin on ASCIll-muotoinen XYZ-koordi-
naattilistaus. Formaatissa ei ole mukana ominaisuustietoja, joten se sopii vain pelkkien
koordinaattien siirtoon. Lisaksi suuri maara pisteita aiheuttaa merkittdvaa hidastumista
luku- ja kirjoitusprosessissa. Taulukossa 1 on kuvattu XYZ-formaatista yksinkertaisin

muoto.
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Taulukko 1. Esimerkki XYZ-formaatista [21].

X Y Y4

-0.007305 0.479848 -1.825868
-0.071243 0.478286 -1.821239
-0.070341 0.478542 -1.822264

3.2.3 Sisaisia formaatteja

BIN

BIN on yleisnimitys bindarimuotoiselle formaatille. Muun muassa CloudCompare tallen-
taa ohjelman sisaiset tallennukset tdhan formaattiin. Yleensa bin-paate tarkoittaa binaa-

rimuotoista tiedostoa, jota voi lukea vain tiedoston muodostanut ohjelma. [22]

FBI

FBI on Terrasolidin kehittdma fast binary -formaatti. Kehittaja suosittelee tata formaattia

kaytettavaksi pistepilvien prosessoinnin ajan. [23]

PTS ja PTX

PTS ja PTX ovat Leican kehittamia laserpistepilven kasittelyformaatteja. PTX on pakattu
versio PTS-formaatista. Intensiteetin ja variarvojen tallentaminen koordinaattitiedon li-
saksi ovat vahvuuksia verrattuna esimerkiksi XYZ-formaattiin. PTS-formaatille on myos
helppo tehdd muuntimia. Heikkous on tekstimuotoisuus, joka vie enemman prosessoin-

titehoa kuin binaarimuotoinen formaatti. Taulukossa 2 on esimerkki PTS-formaatista.

Taulukko 2. Esimerkki PTS-koodista [24].

Number of points / X' Y 4 Intensity value R G B
342684
4.246445  -6.42662 -50.214615 -399 66 50 83
-9.318283 -6.014053 -51.129257 -437 132 141 152

-4.043655 -14.000992 -65.560776 -332 69 61 85
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4 3D-mallin perusteet

Tassa jaksossa on esitelty lyhyesti, mitd 3D-malli sisaltda ja mitd erilaisia sdaddoksia
Suomessa on kehitetty tahan liittyen. Tassa tyossa keskitytdan inframalleihin. Nykyaan
tietomallien vallatessa alaa perinteiseen malliin tulee paljon lisda informaatiota, mutta

perusteita ne eivat laita uusiksi.

Suomessa mallinnusta koskevien ohjeistusten paamaard on yhtenaistaa tapoja ja
termistdd sekd auttaa ndin eri osapuolten valistd kommunikointia. Maailmalla
kansainvaliset organisaatiot, esimerkiksi Open Geospatial Consortium (OGC), ASTM In-
ternational ja Web3D Consortium, ovat kehittdneet standardeja ja kaytantoja

yhtenaistamaan mallinnusta.

4.1  Miké on 3D-malli?

3D-malli on matemaattisen prosessin tulos jostain fyysisesta kohteesta. Kayttokohteita
sille on paljon. Peli- ja elokuvateollisuus luovat mallinnuksen avulla virtuaalitodellisuuk-
sia, terveysteknologiat hyodyntavat mallinnusta l1aakkeiden ja elimiston kuvantamisessa
ja esimerkiksi markkinointia kehitetaan houkuttelevammaksi aidomman nakaisilla tuote-
kuvilla. [25] Edelld mainitut kayttdtarkoitukset ovat olleet olemassa jo pitkdan, ja uusia
tapoja hydodyntaa mallinnusta tulee jatkuvasti lisda. Maanmittaustekniikassa yksi tapa
hyddyntaa 3D-mallinnusta on kaupunki- ja tietomallit. Kaupunkimallit ovat kaupunkien ja
kuntien yllapitamia kolmiulotteisia malleja, joihin voidaan ohjelmoida tietoa eri kohteista
riippuen halutusta lopputuloksesta. [26] Yha enemman ne ovat kaupungin topografisia
tietokantoja, eli semanttisia kaupunkimalleja [27]. Tietomalleja kaytetdan rakentami-
sessa ja erilaisten kohteiden yllapidossa. Niiden tarkoitus on kerata kohteesta mallinnet-

tuihin objekteihin kaikki tarvittava tieto.

3D-mallit jaetaan kahteen kategoriaan esitystavan ja laskennan mukaan: kappalepohjai-
nen- (solid/volume) ja pintamalli (surface). Kappalepohjaisessa mallinnuksessa kohteet
esitetaan erilaisina massoina, joita tarvitaan esimerkiksi laaketieteessa, teollisuudessa
ja muissa suurta tarkkuutta vaativissa sovelluksissa. Pintamallissa kappaleesta esite-
taan vain "kuori” ja sen tarvittavat yksityiskohdat, jolloin varsinaista sisusta ei tayteta.

Esimerkiksi kaupunkimallit ja muut ymparist6a kuvaavat mallit ovat pintamalleja.
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Pistepilvestd muodostettua pintamallia kutsutaan nimella mesh—model (verkko). Kuvan
3 mukaan verkko eli mesh sisaltda nurkkia (vertices), sarmia (edges), tahoja (facets),
polygoneja (polygons) ja pintoja (surfaces). Nama yhdessa muodostavat halutun muo-
toisen mallin. [28]

R S =
Tl 2bpe
- YO

Kuva 3. Mesh koostumus [29].

On myo6s erilaisia keinoja mitata mallia. Yleisimmat naista ovat tarkkuus ja resoluutio.
Mallin tarkkuus tarkoittaa sita, kuinka paljon pisteet poikkeavat todellisesta. Resoluutio
taas kertoo, kuinka monta pistetta mallissa on neliometrilla. Kuvassa 4 esitetdan pisteti-
heyden mukaan yksi tapa, miten malleja voidaan luokitella. Sen laatinut Felix Rohrba on
maaritellyt hanen mukaansa yleisimmat kaytetyt tiheydet taulukkomuotoon. Pistetiheys
eli resoluutio on Rohrban mukaan yksi tarkeimmista mittareista, kun maaritelldan piste-
pilvia. [30] Tiheyden mukaan voidaan myo6s arvioida projektin kustannuksia, silla tar-

kempi aineisto maksaa yleensa enemman kuin epatarkempi.

* Basic Surface Flood Modelling * Multi-purpose * Basic 3D models * Detailed 3D city
Anplicat] Model Dam and Water data sets models
Epiicasion * Forest Inventory Inundation
Calculations

Kuva 4. Pistetiheys ja mallin resoluutio [31].
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4.2 3D-mallin formaatit

Mallinnuksen formaatit voidaan karkeasti jakaa sisaisiin formaatteihin ja siirtoformaattei-
hin. Naiden kahden ero on siind, miten formaattia kaytetdan. Siirtoformaateilla siirretdan
aineistoa, minka vuoksi niiden tietorakenne on yleensa hyvin pakattu ja ne ovat yhteen-
sopivia monen eri ohjelmiston valilla. Ominaista on myds, ettei useimmat kaytettavat oh-
jelmistot pysty hydédyntdmaan naita formaatteja suoraan, vaan ne muunnetaan binaari-

muotoisiksi sisaisiksi formaateiksi. Tall6in ohjelmisto toimii tehokkaammin.

Tassa tyossa kaytettavia siirtoformaatteja olivat Wavefront Technologiesin kehittdma
OBJ ja Autodeskin kehittdma FBX. Molempiin pystytdan tallentamaan tietoa tekstimuo-
dossa, mika on yleista aineiston siirtoon tarkoitetuille formaateille. Tekstimuotoiselle for-
maatille on myos helpompaa tehda muunnos sisaiseen formaattiin, silla niiden sisalta-
maa tietoa pystyy lukemaan selkokielisesti. FBX-muoto on Autodeskin eri tuotteille so-
piva siirtoformaatti, mutta sitd kaytetddan myos muihin sovelluksiin. OBJ-muodossa jae-

taan esimerkiksi Helsingin kaupungin kolmiulotteinen aineisto.

Yksi keino vahentaa yhteensopivuusongelmia ja kaytettavien formaattien lukumaaraa
olisi standardisoida tekniikoita ja toimintatapoja. Tata tehdaan, mutta hidas standardoin-
tiprosessi ei ole pystynyt vastaamaan tekniikoiden kehitysnopeuteen. Prosessin aikana
tarpeet saattavat muuttua, jolloin standardoinnissa ei pystyta taysin vastaamaan viime

hetken muutoksiin. [32]

4.3 Mikéa on LOD?

LOD (Level Of Detail) tarkoittaa mallin resoluutioluokittelua. Peliteollisuus on kayttanyt
LOD-luokittelua vahentamaan kolmioiden maaraa kohteista, joita ei ole oleellista nayttaa
pelaajalle tarkasti. Luonnollisesti talld simuloidaan ihmisen ndkéa, jolloin kauempana
olevat kohteet nakyvat suuripiirteisemmin kuin lahempana olevat. Tietokoneiden kehi-
tyksen alussa grafiikkaprosessointitehoa on ollut kaytettavissa rajallisesti, jolloin LOD on
auttanut myos kaytettdvyyden optimoinnissa. Nykydan pelikoneiksi tarkoitetut laitteet
ovat paljon tehokkaampia, joten peliymparistdsta voidaan tehda tarkempaa ja yksityis-

kohtaisempaa, mutta vielakin LOD on laajasti kaytdssa. [33]
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LOD-luokittelua kaytetdan myds muuhun 3D-mallintamiseen. Esimerkiksi kaupunkimallit
kayttavat LOD-luokittelua kuvaamaan kuinka paljon informaatiota on mallinnettu. Kuiten-
kin LOD-luokitteluksi tunnistetaan parhaiten neliportainen asteikko: LOD1 on massa-
malli, LOD2 rakenteellinen kuorimalli, LOD3 tyypillinen mittausmalli ja LOD4 yksityiskoh-
taisin malli. Taman jaottelun pohjalta James Still on onnistunut luomaan hyvan esimerk-
kimallin [34]. Kaupunkimallit Helsingilla, Espoolla ja Vantaalla ovat kirjoitushetkella

LOD2-luokassa, joka tarkoittaa kaytanndssa kattojen yksityiskohtien mallintamista.

4.4 3D-mallinnuksen vaatimukset ja luotettavuus

3D-mallinnuksen lahtokohta on tarjota mahdollisimman todenmukainen tietokonemalli
halutusta kohteesta. Tahan tarkoitukseen on kehitetty erilaisia mittareita, joita yksi on
edellisessa kappaleessa mainittu LOD-luokittelu. Mallintamisen yleistyessa on jouduttu

laatimaan ohjeistuksia, jotta malleista tulisi yhteensopivia keskenaan.

Tietomalleihin siirryttdessa on myos ollut pakko maaritella joitain reunaehtoja siihen, mi-
ten malleja tuotetaan ja miten laadunvarmistus toimii. Suomessa Liikennevirasto on ollut
aktiivinen tdman suhteen ja laatinut viimeisimman aiheeseen liittyvan ohjeistuksen

12/2017, jossa annetaan useita suosituksia kaytannon tyétavoiksi. [35]

Paakohtia ohjeessa ovat mittausperustan hyva luotettavuus, toimiva aikataulu ja jatkuva
laadunvarmistus. Mallinnuksen pitaa pohjautua luotettavaan ja tarkkaan aineistoon, jotta
lopputulokseenkin voidaan luottaa. Kokonaisprosessin aikataulutus pitaa laatia tarpeeksi
joustavasti, jotta virheiltd valtytdan. Niiden korjaaminen prosessin loppuvaiheessa on
tydlasta ja kallista. Lisaksi hyva laadunvarmistus takaa sen, etta lopputulokseen voidaan

luottaa.

Toinen Suomessa aktiivinen toimija on BuildingSMART Finland -yhteisd, jolla on tieto-
malleihin perustuvat ohjeistukset kaikenlaiseen rakentamiseen. He ovat laatineet Liiken-

nevirastoa kattavamman ohjeistuksen, joka valmistui vuonna 2016. [36]

Yhteinen tekijd molempien tahojen ohjeistuksissa on, ettd mallinnus riippuu projektin
suunnittelusta, luonteesta ja kohteesta. Jokaisella projektilla on sopimuskohtaiset tark-

kuus- ja resoluutiovaatimukset.
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5 Tiedonhankinta

Tiedonhankinta oli melko haastavaa, silla aihe on uusi ja ala suhteellisen pieni. Kirjalli-
suus vanhenee todella nopeasti, ja padasiassa saatavilla oli vain mittaustekniikoihin liit-
tyvia aiheita. Internet on tuonut erilaiset keskustelualustat ja tieteellisten tutkimusten jul-

kaisut kayttddn, joihin nykypaivana yha suurempi tieto keskittyy.

Insinoritydn tietoldhteitd olivat keskustelupalstat, opinnaytety6t ja diplomity6t seka jul-
kisia tutkimuksia ja ohjeistuksia. Lisaksi neuvoja ja ohjeita kysyttiin suoraan ohjelmien
kehittdjiltd ja yhteisoiltd. Suurin osa varteenotettavasta materiaalista oli englanniksi.

Vain ohjeistuksia ja muuta yleista tietoa I6ytyi suomeksi.

Erityisesti laserkeilaukseen ja pistepilvien kasittelyyn keskittynyt Laserscanning forum
tarjosi paljon kayttajien omakohtaisia kokemuksia ja harmaata tietoa, jota ei kirjoista tai
tutkimuksista 16ydy. Sivuston kayttajat ovat padosin maanmittausalan parissa toimivia

henkil6ita, jotka esiintyvat omilla nimillaan ja edustavat omia yrityksiaan.

lImakuvien prosessointiin liittyviin kysymyksiin vastasi Photoscanin foorumilla ohjelman

kayttajat mutta myos itse ohjelmiston kehittaja.

CloudComparella on oma yhteisdwiki, josta l6ytyy erittéin paljon ohjeita ja paivitettya tie-
toa ohjelmasta. CloudCompare forum oli yhta lailla suurena apuna juuri ongelmia ja oh-
jelmistovirheitd kohdatessa. Foorumilla kysymyksiin vastasi ohjelmiston kehittaja, joka

teki ohjelmistopaivityksia erittdin nopeasti ohjelmistovirheiden esiintyessa.

Keskustelupalstoilta saatuun tietoon tulee suhtautua kriittisyydell3, silla joskus tieto saat-

toi olla jo vanhentunutta johtuen jo tulleista ohjelmistopaivityksista.

Lisaa ajatuksia 3D-mallintamisen tulevaisuudesta ja siitd, miten se kehittyy Suomessa,
tuli rakennus- ja maanmittausalan ammattilaisilta, tietomalliasiantuntijoilta, virkamiehilta

seka ohjelmistokehittajiltd Diginfra 2018 -seminaarissa.
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6 Koetyo — Karamalmin kampusalue

6.1 Johdanto

Koetydn prosessikaavio ndkyy kuvassa 5. Tarkoituksena oli tehdd mahdollisimman no-
pea ja kevyt mutta tarkka menetelma, jolla teksturoitua mallia voidaan tuottaa. Kevyt
tarkoittaa tassa tapauksessa sita, etta mallissa on mahdollisimman vahan tahoja, minka

ansiosta mallin kasitteleminen nopeutuu.

Aineiston kerayksen jalkeen siitd prosessoitiin erilliset pistepilvet. Pisteet luokiteltiin kar-
keasti eri luokkiin ja taman jalkeen ne yhdistettiin niin, etta tarkennusaineistoja kaytettiin
paikkaamaan fotopistepilvesta poistettavia huonoja kohtia. Yhdistamisvaiheessa tehtiin

my0s erilaisia optimointeja. Lopuksi aineisto kolmioitiin.

Kopteri
limakuvat Photoscan Terrascan
. . Pistepilvien

. . / FEeTEI S luokittelu
Signaali
mittaukset CloudCompare

: Kolmiointi
Takymetri Pistepilvien
yhdistaminen Teksturointi
tarvittaessa
Laserkeilain Cyclone
Laserkeilaus Laserdatan
data + esikasittely
R_GB__ ZIALS) . Terrascan
pisteille Kojeasemat
yhdistetaan Pistepilvien
yhdeksi luokittelu

. ; pistepilveksi
Slgnaall (unify) tai
mittaukset jatetaan erikseen
Takymetri

E57 tai PTS muunnos
—> LAS
(Esim. CloudComparella)

Kuva 5. Prosessikaavio.
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6.2 Pohja-aineiston kerdaminen

Pohja-aineistoksi ilmakuvattiin Karamalmin kampusalue. Ty6ta varten kaytettiin vain Ka-
raportilta ja sen [ahiymparistdsta saatua aineistoa. Kopterina kaytettiin Metropolian omis-
tamaa Camflight FX8 -kopteria ja kamerana Sony Alpha 7R sekd 35 mm linssia. Kuvassa

6 naytetdan koko alueen ilmakuvattu ala.

Kuva 6. limakuvattu alue.
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Lentosuunnitelma

Lentosuunnitelma laadittiin Virtual Cockpit (versio 2) -ohjelmalla (kuva 7). Sovellus on
suunniteltu Lockheed Martinin valmistamaa Kestrel-autopilottia varten. [37] Suunnitel-
maan kuului pystykuvia 90 asteen kulmasta seka viistokuvia 60 asteen kulmasta. Viisto-
kuvien avulla tutkittiin, saisiko talojen seiniin verrattavia kohteita paremmin havainnoitua.
Tarkoituksena oli saada mahdollisimman hyva aineisto ajoradoilta. Talléin muun muassa

reunakiveykset erottuisivat selkedmmin.

limakuvausta varten tehtiin kaksi lentosuunnitelmaa, yhden pystykuvilla ja yhden viisto-
kuvilla. Viistokuvien lentosuunnitelma toteutettiin yksittdisten waypoint-pisteiden avulla

ja pystykuvat area waypoint -ruudukolla.

s tome | |Check senzor | Fs-

Spe  COMITISN0SN-1  NG02191377 £24 7490523 (N 592381 5m. £ 2750456 25m) Sim: N/C, Dev: N/C KEVBOARD.

Kuva 7. Ruutukaappaus Virtual Cockpitista. Esimerkkikuva ohjelmandkymasta.

Area Waypoint

Area Waypoint -tekniikkaa (kuva 8) kaytettdessa ohjelma laskee valmiit lentoradat ja ku-
vanottopaikat. Ruudukko asetellaan Google Earthista saatavan satelliittikuvan paalle ja
lentosuunnitelman parametrit sdadetaan siten, ettd kopterin gimbaali eli kameravakain
pitdd kameran kohtisuoraan alaspain lennon aikana. Tassa menetelmassa ohjelma las-

kee kuvanottopaikat annetun lentonopeuden, pituus- sekd leveyspeiton ja
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lentokorkeuden mukaan. Lahtétietoina ohjelmaan syoétetdan lisdksi kaytetyn kameran
tiedot ja sen kuvausparametrit.

Kopterin toimittajan (Camflight AS) suosituksesta kaytettiin 70 %:n pituuspeittoa, 70 %:n

leveyspeittoa, 120 m:n lentokorkeutta seka lentonopeutta 5 m/s.

Kuva 8. Esimerkkikuva areawaypoint-ruudukosta.

Waypoint-pisteet

Yksittaisia waypoint-pisteitd (kuva 9) kaytettaessa satelliittikuvan paalle sijoitetaan pis-
teitd, joiden kautta lennokki lentda. Pisteille voidaan antaa erilaisia parametreja, jotka
vaikuttavat lennokin kayttaytymiseen kyseisella pisteella. Tassa lentosuunnitelmassa
annettiin "Term Mode” -parametriksi “pass through”, koska lennokin haluttiin vain
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lentavan pisteiden kautta, eikd esimerkiksi jdavan kyseiselle pisteelle paikalleen muuta-

man sekunnin ajaksi.

Yksittaisia waypointeja kaytettaessa kuvanottopaikkoja ei ollut maaritelty lentosuunnitel-
maan, kuten area waypointeja kaytettdessa. Kuvien ottaminen oli tasta syysta kaynnis-
tettdvad manuaalisesti sen jalkeen, kun kopterille oli annettu kasky lentda lentosuunni-
telma. Kaytettavissa olevalla kameralla seka valituilla asetuksilla kuvanottovaliksi valittiin
kolme sekuntia. Lisdksi suunnitelmaan annetut parametrit eivat vaikuttaneet kaytetta-
vissa olevaan gimbaaliin, joten paras vaihtoehto oli tehda saadot kasin lennon aikana.

ey

Spd (m/s) Alt1
5.0 10.1
Payload ~A
Payload Window | 2
North (m) Eas
6692305.50 136
Term Mode
Pass Through v
Transit Mode

-

Kuva 9. Esimerkki waypoint-pisteista.

Havaintojen perusteella pystykuville paras tapa oli kayttdd area waypoint -ruudukkoa ja
viistokuville yksittaisia waypoint-pisteitd manuaalisella kuvanotto-ohjauksella lennon ai-

kana. Kuvauskulma viistokuville oli 60 astetta kumpaankin suuntaan.
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Signaalien rakentaminen ja kartoitus

liImakuvat orientoitiin maahan rakennettavien signaaleiden perusteella. Osa signaaleista
maalattiin Espoon kaupungilta saatujen kayttokiintopisteiden paalle (kuva 10) ja loput
maalattiin sopiviin kohtiin (kuva 11) seka kartoitettiin satelliittimittauksella. Signaalit mi-
tattiin satelliittimittauksella kolmella eri alustuksella, joiden pohjalta otettiin keskiarvo.

Signaaleiden tiedot kerattiin tekstimuotoon.

Kuva 10. Espoon kaupungin kiintopiste ilman signaalia.



27

Kuva 11. limakuvaussignaali.

Lentotilanne

Lentosuunnitelman ja signaaleiden merkinnan jalkeen etsittiin sopiva nousu- ja lasku-
paikka kopterille. Nousu- ja laskeutumispaikaksi kannattaa valita mahdollisimman avoin
paikka, jotta kopteria on helpompi ja turvallisempi lennattda. Kohdealueella oli paljon ra-
kennuksia, joten hyvaksi tukikohdaksi valittiin laajahko parkkipaikka. Paikan valintaan
vaikuttaa Trafin maarays "Kauko-ohjatun ilma-aluksen ja lennokin lennéttdminen”, jonka

mukaan lennattajalla on oltava suora ndkdyhteys kopteriin koko lennon ajan. [38]

Lentosaa vaikuttaa kopterin toimivuuteen, joten paiva kannattaa valita huolellisesti. Kop-
teria ei voi lennattda, jos tuulee tai sataa lilkaa. Paras sada ilmakuvauksen kannalta on
yhtenainen pilviverho, jonka lapi aurinko paistaa. Nain maanpinnalla on mahdollisimman
tasainen valo ja ilmakuvista tulee tasalaatuisia ja selkeitd. Auringonpaisteesta johtuvat
varjot aiheuttavat kuvien prosessoinnissa ongelmia, jolloin alueesta saattaa tulla kaytto-
kelvoton.
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Ennen nousua suoritettiin tekniset valmistelut. Niihin kuului kopterin akkujen ja siipien
kiinnittaminen, seka kaynnistaminen ja turvallisuustestit. Turvallisuustesteihin kuului
muun muassa kopterin kunnon tarkistaminen silmamaaraisesti seka yhteyksien ja las-
kuvarjon avausmekanismin tarkistaminen. Luotettavan yhteyden varmistamiseksi kopte-
ria oli mahdollisuus ohjata seka erikseen tehdylla kauko-ohjaimella etta tietokoneella Vir-

tual Cockpit -ohjelmalla. Lentosuunnitelma ladattiin tietokoneelta kopterin muistiin.

Valmistelujen jalkeen lennettiin ensin kaksi noin 25 minuutin lentoa, joiden valissa vaih-
dettiin akkusarja. Toisena paivana lensimme loput suunnitelmasta yhdella lennolla. Nou-
sut ja laskut tehtiin manuaalisesti kauko-ohjaimella ja sen jalkeen autopilottia kaskettiin

suorittamaan lentosuunnitelma. Lennon ajan kopteria seurattiin katseella.

6.3 Pohja-aineiston prosessointi

llImakuvatun aineiston prosessointiin kaytettiin Agisoft Photoscan (versio 2.9.1) -ohjel-
mistoa. Sen avulla tuotettiin yhtenainen pistepilvi LAS-formaatissa seka ortokuva teks-
turointia varten. Fotopistepilvi sisalsi koordinaattien lisaksi RGB-arvon jokaiselle pis-

teelle.

Ennen kuvien viemista kuvaprosessointiohjelmaan kuvien metatietoihin lisattiin kopte-
rista saadut parametrit (kuva 12). Parametreja olivat kuvanotto ID, kuvan numero, auto-
pilotin aikaleima ja karkeat koordinaatit kuvanottohetkelta. Yhdistaminen tehtiin Virtual

Cockpit -ohjelman lisdosalla Image Matcher.

Prosessoinnissa noudatettiin ohjelmiston valmistajan omaa ohjeistusta, joka I0ytyi

heidan internetsivuiltaan. [39]

Kuvassa 13 nadkyivat virheet, joita tuli prosessoinnissa. Kokonaisvirhe oli alle 5 cm.
Kaikkia signaaleita ei voitu ottaa laskentaan mukaan, silla virheet olisivat kasvaneet lilan
isoiksi. Valintaruudulla valitut kuvat otettiin laskentaan mukaan. Kopteriin kiinnitettavan
gimbaalin moottorit alkoivat varisemaan tietyissa olosuhteissa lennon aikana, jolloin
myos siihen Kiinnitetty kamera tarisi. Nain ollen kuvista tuli epatarkempia. Havainto
tehtiin vasta lentojen jalkeen. Koetyossa ei ollut aikataulusyistd mahdollista suorittaa

lentoja uudestaan, joten epatarkkoja kuvia yritettiin valttaa lopputuloksessa.
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Control points
Check points

Easting (m)

25486245.908000
25486233.574000
25486484,547000
25486689.827000
25486653.540000
25486603.617000
25486405.278000
25486372.520000
25486332.018000
25486432.562000
25486539.472000
25486393.911000
25486247.255000
25486512.248000
25486269.981000

Northing (m)

6678962.377000
6678813.783000
6678716.814000
6678781.132000
6678984.307000
6679092.996000
6678943.475000
6678232.390000
6678376.456000
6679033.356000
6678718.488000
6678472.416000
6678320.371000
6678657.926000
6678202.954000

Altitude (m)
34.337000
33.844000
32.402000
29.157000
31.879000
34.280000
32.685000
26.186000
26.327000
33.954000
36.315000
27.491000
26.337000
36.559000
26.027000

Accuracy (m)
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000
0.025000

Error (m)
0.041983
0.062322
0.034890
0.069906
0.038757
0.050636
0.010386

0.066044

0.038074

0.049144

Projections
21
22
17
25
21
34
26

10

1"

Error (pix)
0.202
0.308
0.546
0.250
0.332
0.342
0.225

0.330

0.299

0.321

Kuva 13. Virheet ilmakuvaprosessoinnissa. Yksinumeroiset pisteet kartoitettiin tata tyota varten ja
viisinumeroiset Espoon Kaupungin kayttokiintopisteille maalattuja signaaliristeja.
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6.4 Laserkeilaus

Projektiin ~ varten  hankittiin  tarkennusaineisto  Leican = P30-laserkeilaimella.
Laserkeilausaineiston tarkoitus oli parantaa ilmakuvista fotogrammetrian avulla tuotetun
pistepilven resoluutiota halutuilta alueilta. Laserkeilattavaksi alueeksi valittiin

campusalueen padkatu seka sen valitdntd ymparistda.

Projektissa kaytetyn laserkeilaimen (kuva 14) yhden pisteen etaisyysmittauksen
tarkkuus oli 1.2 mm + 10 ppm. Vaaka- sekd pystykulman kulmatarkkuus 8”. 3D-
sijaintitarkkuus 3 mm 50 metrissa ja 6 m 100 metrissa. Skannauskulma vaakakehalla oli
360 astetta ja pystykehalld 290 astetta. Tahyksind kaytettiin paperisia 6”:n
mustavalkotahyksia (kuva 15) seka Leican pallotahyksia (kuva 16). [40]

Kuva 14. Leica P30 laserkeilain.
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L.

Kuva 15. Mustavalkotahys. Kuva 16. Pallotahys.

Pistepilvien rekisterdintia varten tahykset mitattiin Trimble S6 -takymetrilla. Takymetrin
orientointi tapahtui Espoon Kaupungin E5-luokan kayttdkiintopisteiden avulla tunnetun

seka vapaan asemapisteen orientointina.

Tahykset sijoitettiin siten, ettd kahdella vierekkaisella laserkeilauksen kojeasemalla on
vahintdan kaksi yhteistd tahysta. Talldin pistepilvien rekisterdinti onnistuisi tahysten
avulla, eika pilvi pilved vasten rekisterdintia tarvitsisi tehda, jolloin valtetddn manuaalista

tyoskentelya.

Kojeasemien alustavat sijainnit suunniteltin ennen tdhysten kiinnittdmista maastoon.
Talla pyrittiin varmistamaan, etta kaikki halutut tahyksen nakyvat kustakin kojeasemasta
ja valtymme ylimaaraisilta kojeasemien siirtelyiltd jonkin tahyksen jaadessa esimerkiksi

lyhtypylvaan taakse laserkeilaimesta katsottuna.

Tahysten nakymisen pistepilvissa tunnistamalla ne laserkeilamen “pick target’-
toiminnolla. Myds paperisten mustavalkotahysten sekd pallotahysten havaittavuutta.
Huomattiin, ettd paperiset tahykset ovat helpompia tunnistaa "pick target” -toiminnolla

pidemmalld matkalla kuin pallotdhykset.

Kojeasemia oli yhteensa 16 kpl. Kojeasemilla 1-9 otettiin valokuvat, jotta pistepilvien
pisteille saadaan RGB-arvo. Varivalokuvien ottamisesta luovuttiin ajankaytollisista

syista. Tasta syysta varivalokuvia ei otettu kojeasemilla 10-16.
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6.5 Laserkeilausdatan prosessointi

Cyclonella suoritettiin laserpistepilvien rekisterdinti, kojeasemien yhdistamisen yhdeksi
pistepilveksi sekd laserkeilauspistepilvien karkeaa silmamaaraistd siivoamista

tarpeettomista pisteista.

Kaytimme aineiston keruussa Leican P30-laserkeilainta. Kojeesta saatavat usean
laerkeilausaineistot oli helpointa kasitella valmistajan omassa ohjelmassa. Erityisesti
kojeasemien rekisterdinti ja pistepilvien yhdistaminen ovat Cyclonella tuotettuina erittain

laadukkaita.

Halutut kohdat pistepilvesta kirjoitettin PTS- tai E57-formaattiin, koska Cyclone ei

tukenut LAS-vientia kirjoitushetkelld ja ndma kaksi olivat tiedostomuotoja, joita CC luki.

6.5.1 Leica Cyclonen tietokannan rakenne

Cyclonen luoma IMP-tietokanta koostuu projektitiedostosta, joka sisaltad kaiken
keilausdatan. Projektikansio pitaa sisallaan jokaisen kojeaseman, jota Cyclone kutsuu
nimelld ScanWorld. Yksittainen ScanWorld jakautuu kansioihin, joita ovat ControlSpace,

ModelSpace, Scans ja Images. (Kuva 17.)
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Kuva 17. Cyclone tietokanta.
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ControlSpace on pistepilvi, jossa ovat keilausdata ja pistepilvessa olevat tahykset. Kun

rekister6intid tehdessa pistepilvid yhdistetaan,

Cyclone viittaa tahan kansioon.

ControlSpaceen tulisi tehda muutoksia ainoastaan, mikali tahyksia taytyy lisata tai niiden

sijaintia halutaan muuttaa.

ModelSpace on myo6s pistepilvi, jossa ovat kojeaseman keilausdata seka tahykset.

Rekisterdinnin yhteydessa luodaan rekisterdity ModelSpace, joka on yhdistetty usean eri

kojeaseman pistepilvista. Jos pistepilveen aikoo tehda muutoksia, sitd haluaa tarkastella

tai sieltd haluaa poistaa jotain, tulisi se tehda ModelSpace:een. ModelSpaceja voi luoda

useamman joko kopioimalla se kokonaan tai kayttamalla aita-tyokalua pistepilvea

tarkastellessa.

Scans-kansio pitda sisallaan kojeasemakohtaisen keilausdatan seka "pick target'—

toiminnolla skannatut tahykset. Tahan nakymaan ei voi tehda muutoksia.
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Images on kuvakansio, joka sisaltda keilaimen ottamat valokuvat seka Multiimage-
alikansion. Avaamalla Multiimage-alikansion voi tarkastella valokuvista muodostettua

panoraamakuvaa tai yksittaisia valokuvia.

6.5.2 Leica Cyclone -tietokannan luonti

Ennen tietokannan luomista ensimmaistd kertaa on tiedostojen hallinnan vuoksi
suotavaa valita, mihin Cyclone-tietokanta kovalevylla tallennetaan, valitsemalla Edit ->
Preferences ja siirtymalld Scan-valilehdelle. Tietokantoja kopioitaessa tai siirrettdessa
tulee koko tietokantakansio kopioida, jotta tiedonsiirrossa ei tapahdu virheitd ja data

korruptoidu.

Name Type Size
eventlog File folder
karamalmi_databaseFsfSets File folder
recovery File folder
@ karamalmi_database.imp Trimble imported ... 9271680 KB

Kuva 18. Cyclone tietokannan kansiorakenne.

Tietokannan luominen alkaa serverin valitsemisella. Valmistaja suosittelee kayttamaan
jakamatonta (unshared) serveria Cyclonen toiminnan optimoimiseksi jaetun (shared)
sijaan. Kaytimme jakamatonta serverid, silla tietokantoja ei tyostetty verkossa vain

ainoastaan tietokoneen kovalevylla.

Tietokanta luodaan valitsemalla Configure -> Database -> Add. Tietokannan nimeksi voi

antaa, minka haluaa, mutta “Database Filename” tulee jattaa tyhjaksi. (Kuva 19.)
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Server | ETY-42110-09 [unshared) v
| Databases &’ Add..
%) Add Database X Remaove
Database Name |M}' Database] | Destray
Database Filename | |D Compact
Optimi
| oK | ’ Cancel ‘ e
I Admin Login...

Kuva 19. Cyclone tietokannan luominen.

Laserkeilausdataa voi tuoda Cycloneen monella eri tapaa monesta eri lahteesta. Leica
P30-laserkeilaimen data tuotiin tietokantaan valitsemalla Import ScanStation Data ->
Import ScanStation Project. (Kuva 20.)

ﬂi File Edit View Configure Create Tools Help

Open RS
Open Temporary ModelSpace View

o |

Create and Open ModelSpace View
Open TruSpace

Update Original ModelSpace

Import...

Import Panoramic Images...
Batch Import...

Import Leica System 1200...

Import Geometric Objects...
Import ScanStation Data > Import ScanStation Project...

Import MultiStation MS50 Data > Import ScanStation Partial Project...
Import as Auto Align Project >

Import Pegasus Project...
Export...

Store in JetStream ProjectVault...

Exit

Kuva 20. Cyclone datan sisaan lukeminen.
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Import-valikon parametreista valittiin “Find B&W Targets” seka “Estimate Normals”, silla
tahykset oli skannattu laserkeilausten aikana. Muuten ohjelman oletusasetukset pidettiin

paalla. (Kuva 21.)

%

General  Advanced

SubSample
100% v
Pre-Reaistration Options
Find B&w T argets g" v

[] &uto &lign Scans

[] Generate Scan Thumbnails

Map Colors
E stimate Normals
[ Find Pipes Automatically

Min Diameter m v
Max Diameter m v

B, PP [_',' All

oK Cancel

Kuva 21. Cyclone sisaan luettavan aineiston ominaisuudet.

Laserkeilausdatan tuominen tietokantaan voi kestaa kymmenistd minuuteista tunteihin

riippuen tuotavan aineiston suuruudesta.

Takymetrilla mitatut tdhykset tuodaan tietokantaan valitsemalla projektikansiosta Create
-> Scanworld ja Iluomalla uuden ScanWorldin, jonka voi vapaasti nimeta.
Tekstimuodossa olevat tahysten koordinaatit CSV-tiedostomuodossa tuodaan luotuun
ScanWorldiin valitsemalla ScanWorld -> Import. Sarakkeet voivat olla eroteltuina joko
pilkulla, valilla, puolipisteelld tai sarkaimella. Tahysten numerointi tai nimi tulee olla
sarakkeessa “Target ID”. Lisdksi x, y ja z-koordinaatit voivat olla vaarissa sarakkeissa,

joten niiden jarjestysta tulee talléin muuttaa. (Kuva 22.)
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%
File Edit View Configure Create Tools Help
D) Import: ASCII File Format X
=2 = I
Format | Survey Default v | | Saveds..
O Fixed Width # of columns |4 S
@® Delimited # Rows to skip [p =
Tab []  Semicolon []  CommentMarker |
S >
R Other D Negative Value | - v
Comma []
Unit of Measure | paters v

Merge consecutive delimiters

" O Create line segments between
Text Qualifier D pairs of vertices

[JasPointCloud  Options. . Auto Preview Preview

Column 1 Column2 Column3 Column4

Text Decimal Decimal Decimal

1 6679092.27. 25486488.8 36.605

2 6679090.80 25486522.4 35.760

3 6679097.15 254864769 36.483

5 6679115.02 25486563.0 36.104

7 6679059.00 25486573.8 36.501

8 6679045.95 25486592.9 36.532

6 667905240, 25486617.1. 36.407

Kuva 22. Tahysten koordinaattien sisdan luku.

6.5.3 Laserpistepilvien rekisterdinti Cyclonessa

Pistepilvien rekisterdinnilla tarkoitetaan prosessia, jossa eri kojeasemien pistepilvet
yhdistetddn samaan koordinaatistoon. Yhdistdminen tehdaan yhteisten pisteparien,

kuten mitattujen tahysten tai kahden kojeaseman pistepilvien paallekaisyyden avulla.

Tietokannan alla olevasta projektikansiosta valittiin Create -> Registration, johon lisattiin

kaikki halutut kojeasemat seka tahyksille luotu kojeasema.

ScanWorlds’ Constraints -valilehdeltd valittiin tdhysten mitatut koordinatit sisaltava
kojeaseman, joka asetettiin referenssiksi “Set home” -toiminnolla. Talléin koordinaatisto

muodostuu mitattujen tdhysten koordinaattien mukaan. (Kuva 23.)
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egistration Edit ScanWorld Constraint  Cloud Constraint  Viewers  Visual Registration

o &

A ScanWorlds' Constraints (s Consvaint List | ] ModsiSpaces

Groups/ScanWorlds/Constr... Type Status Weight FEmor
= ,“ Ungrouped
Mg Station-001: SW-001 ...
@ h Station-002: SW-002 ...
[+ Station-003: SW-003 ...
Station-007: SW-007 ...
Station-008: SW-008 ...

A
Ao
A
t Station-009: SW-009 ...
A
A

#-F-F

[

targetit_textured t...
Station-006: SW-006 ...
Station-004: SW-004 ...

Kuva 23. Tahykset rekisterdinnissa.

Automaattinen rekisterdinti tdhysten avulla suoritettiin valitsemalla Constraints -> Auto
Add Constraints. Tassa vaiheessa Cyclone etsii pistepilvista toisiaan vastaavia tahyksia,
joita se rekisteroinnissa tulee kayttamaan. Rekisterdinti tehtiin valitsemalla Registration
-> Register, jolloin ohjelma laskee pistepilvien yhdistdmiselle virheet. Kayttaja voi itse

maaritella, mita tahyksia han haluaa ottaa mukaan rekisterdintiin, ja mitka han haluaa
jattaa siita pois.

Constraint  Cloud Constraint  Viewers  Visual Reg
Auto-Add Constraints (Target ID only)
Auto-Add Constraints
Advanced Auto-Add Constraints...

Find Constraints in ScanWorld Group...

Update Constraints

Add Constraint

Enable

Disable

Set Weight...

Add/Edit Registration Label...
Add/Edit Target Height...

Show Constraint

Kuva 24. Rekisterointi tahysten avulla.
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Tahysten avulla suoritetun rekisterdinnin jalkeen valittin Cloud Constraints - Auto Add
Cloud Constraints, jolloin ohjelma etsii kojeasemia, joissa on vahintddn 20 %:n

yhtalaisyys ja pyrkii yhdistamaan pistepilvet paallekaisten pisteiden avulla.

Cloud Constraint  Viewers Visual Registratic
Add Cloud Constraint
Auto-Add Cloud Constraints
Edit Parameters...
Update Initial Cloud Alignment
Optimize Cloud Alignment
Show Diagnostics...

Reset Alignment

Cloud Constraints Wizard...

Kuva 25. Pistepilvein rekisterointi ilman tahyksia.

Kojeasemien valisia yhteisia pisteita lisattiin rekisterdintiin myés manuaalisesti Cloud
Costraint Wizardin avulla etsimalla kahden kojeaseman pistepilvistd vahintaan kolme
yhteista pistetta. Valittavien pisteiden tuli olla vahintdan 150mm tarkkuudella valittuja.
Tata arvoa voi halutessaan muuttaa. Pisteita valitessa valittiin mahdollisimman kaukana

toisistaan olevat kolme pistetta. (Kuva 26.)

%) Cloud Constraints Wizard X
Constraints Station-002: SW-002 Station-003: SW-003 Station-004: SW-004 Station-006: SW-006 Station-007: SW-007
o - - - -

Deselect A1 Ll = [station-001: SW-001 'sj ion-002: SW-002| = E
tation-001: -001:Station-002: &

Select Cycle E E E S E
Scanworlds D D D D D
Hide Selected D D D D D
] | O 4 &
Show Selected D D E] D D
Show All D D D D D

< >

Update Cancel

Kuva 26. Cloud Constraint Wizard.

Kun rekisterdinnin virheet olivat hyvaksyttavalla tasolla, tallennettiin rekisterginti
valitsemalla Registration -> Create ScanWorld/Freeze Registration. Lopuksi loimme

rekisterdidysta pistepilvestd uuden ModelSpacen. (Kuva 27.)
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D) Registration: Registration 1
Registration Edit ScanWorld Constraint Cloud Constraint  Vie

Register

Auto-Update

Show Diagnostics...

Show Traverse Report...

View Interim Results...

Create ScanWorld Groups with Targets...

Create ScanWorld Groups from Selection with Targets...
Merge ScanWorld Groups

Optimize ScanWorld Groups

Create ScanWorld Groups from Auto Alignment
Show ScanWorld Group Info...

Create ScanWorld/Freeze Registration

Unfreeze Registration

Create ModelSpace

Create and Open ModelSpace

Import Registration...

Close

Kuva 27. Rekisteroinnin tallentaminen.

6.5.4 Pisteiden vienti Leica Cyclonesta

Cyclonen kirjoittaa useita eri formaatteja, mutta ei LAS- ja LAZ-formaatteja.
Huomioitavaa on, ettd Cyclonesta saa kirjoitettua E57-formaattia vain kojeasemittain.
Esimerkiksi haluttuja pisteita ei voi valita aita-tyokalulla ja vieda E57 formaatissa ulos,
mikali pistepilvet on yhdistetty Cyclonen “unify”-toiminnolla rekisteréinnin jalkeen. Unify-
toiminnolla voidaan vahentdd paallekkaisia pisteitd seka pistepilven tiheyttda. Tama
parantaa ison pistepilven kanssa tyOskentelya Cyclonessa. Koska pisteet aiottiin
kirjoittaa ulos E57-formaatissa, Unify-toimintoa ei kaytetty. Pisteet Kkirjoitettiin ulos

valitsemalla File -> Export seka haluttu tiedostomuoto.
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6.6 Pistepilvien luokittelu

Tassa tydssa pisteiden luokitteluun kaytettiin Terrasolidin kehittdmaa Terrascan-
ohjelmistoa. Siind olevat tyokalut soveltuvat hyvin seka laserpiste- etta fotopistepilven
luokitteluun ja kasittelyyn. Terrascan on Microstationin lisdosa, joka mahdollistaa suurten

pistepilvien kasittelyn.

Pistepilvet tuotiin Terrascaniin LAS muodossa, jossa ne myds kirjoitettiin ulos. Ennen
pisteiden lukemista Terrascaniin taytyi laserpistepilvelle suorittaa formaattimuunnos.
Cyclonesta ulos kirjoitettu pistepilvi taytyi muuttaa CloudComparella E57-muodosta
LAS-muotoon, silla Terrascan ei lue E57-muodossa olevia pistepilvia. Tama tapahtui
lukemalla pistepilvi CloudCompareen ja tallentamalla se eri tiedostomuodossa.
Photoscanin ilmakuvista tuottaman fotopistepilven saa kirjoitettua ulos LAS-muodossa,

joten formaattimuunnosta ei tarvittu.

liImakuvista tuotettua fotopistepilvea seka laserpistepilvea luokiteltiin erikseen, silla niihin
toimivat hieman erilaiset makrot. Pisteitd luokitellessa pyrittiin  mahdollisimman
automaattisesti suoritettuun luokitteluun. Luokittelua tehtiin automaattisesti makroilla

sekd manuaalisesti valitsemalla pisteita pistepilvesta.

Pisteiden koordinaatit muunnettin  GK25 -lyhyisiin koordinaatteihin vahentamalla

itdkoordinaatista 25 000 000 laskentaprosessin optimoimiseksi.

Pistepilvien suuren koon vuoksi koko aineistoa ei voida luokitella kerralla vaan pistepilvi
taytyy jakaa pienempiin osiin. Taman tehtiin lukemalla joka 100. piste Terrascaniin ja
piirtdmalld pistepilven paalle aluejaon. Rakennusten kohdalla alueet piirrettiin
pienemmiksi kuin sellaisilla alueilla, joissa niita ei ollut. Talla pyrittiin saamaan jokaiseen
piirrettyyn alueeseen lahestulkoon saman verran pisteita. Sisaan luetut pisteet suljettiin,
minka jalkeen valittiin kaikki piirretyt alueet. Piirrettyihin alueisiin luettiin kaikki pisteet
piirretyn aluerajauksen mukaan ja projekti tallennettiin Terrascanin kayttamassa FBI-

muodossa. Ominaistietoina koordinaattien liséksi sisdan luettiin pisteiden vari ja luokka.

6.6.1 Fotopistepilven luokittelu

Fotopistepilvi sisalsi huomattavasti enemman kohinaa kuin laserkeilattu pistepilvi.

Pistepilvessa esiintyvad kohinaa pyrittiin poistamaan luokittelemalla hajapisteitd seka
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tasoittamalla pistepilved "Smooth Points” -toiminnolla. Automaattisella luokittelulla
luokiteltiin  pisteitd maanpinnan pisteiksi, rakennuksiksi seka kasvillisuudeksi.
Fotopistepilven heikon laadun vuoksi tydssa ei onnistuttu luomaan makroa, jolla olisi
paasty luokittelussa yhtd hyvaan tulokseen kuin laserpistepilved luokiteltaessa.

Fotopistepilven luokittelusta suurin osa tehtiin manuaalisesti.

6.6.2 Laserpistepilven luokittelu

Laserkeilattu pistepilvi sisélsi paljon tarpeettomia pisteitd, kuten autoja, ihmisia seka
rakennusten ikkunoiden aiheuttamia heijastuksia, jotka ilmenivat rakennusten sisalla
olevina pisteind. Maasta kasin suoritetun laserkeilauksen pistepilvi on hyvin tasaista
paallystetyn maanpinnan osalta. Yleisestikin tarkasteltuna laserpistepilvessa on
huomattavasti vahemman melua kuin fotopistepilvessa. Tasta syystd maanpintaa
luokittelevasta makrosta jatettiin kokonaan pois “SmoothPoints” -vaihe. Laserpistepilven
luokittelua varten saatiin optimoitua makro, joka luokitteli maanpinnan pisteet siten, etta

se vaati erittain vahan manuaalista luokittelua.
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6.7 Pistepilvien prosessointi ja yhdistdaminen CloudComparella

6.7.1 Pistepilven ominaisuudet

Pistetiheys ja sitd mukaa tahojen (facets) maara on yksi merkittava tekija kevyessa 3D-
mallissa. Luonnollisesti mitd vahemman mallissa on aineistoa, sitd kevyempi sita on pro-
sessoida. Kuvassa 4 (s. 17) on yksi esimerkki siitd, minkalaisia pistetiheyksia voidaan
kayttad. Tahan viitaten kaytimme tasaisilla alueilla noin 1-2 pts/m? pistetiheytta ja yksi-
tyiskohtaisemmilla alueilla jopa yli 10 pts/m?, silla ajoradan yksityiskohteiden ja muiden
paljon muotoja sisaltavien kohteiden haluttiin nakyvan tarkasti. Talla tekniikalla mallin

tiedostokoko laskee, mutta tahojen maara kasvaa.

6.7.2 Pistepilven kasittely

Pistepilven kasittelyyn ja yhdistamiseen kaytettiin CloudCompare-ohjelmaa. Kuvassa 29
esitetdan kasittelyn tydjarjestys. Ensiksi pisteet luettiin ohjelmaan ja pilvesta poistettiin
mahdolliset tuplapisteet ja suurimmat hairiét, jotta laskentatehoa ei kuluisi turhaan seu-
raavissa vaiheissa. Taman jalkeen ajettiin Curvature-niminen laskenta, joka yrittéa so-
vittaa toisen asteen kayrda jokaiselle pisteelle, esimerkiksi paraabelia tai hyperbolia.
Laskennan padamaarana oli selvittda, missa suhteessa maaritettdva piste oli naapu-
reihinsa. [41] Laskennassa kaytettiin Gaussin-kayraa, joka todettiin toimivimmaksi vaih-
toehdoiksi. Muita vaihtoehtoja olivat Mean ja yksinkertaistetun normaalin arvon vaihtelu-
menetelma. Kuvassa 28 annettavalla "kernel”-parametrilla voitiin maarata viereisten pis-

teiden kattavuus.

Curvature =
Curvature [Gaussian v ]
kernel 0.250000 =

[ OK H Cancel ’

Kuva 28. Curvature-dialogi.
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Curvature-prosessi muodosti laskennan perusteella skaalan (scalar field), ja nain saatiin

selville, mitka pisteet ovat tasossa ja mitkd kaarevissa kohdissa. Jos yhtal6a ei voitu

sovittaa vierekkaisten pisteiden vahyyden vuoksi, ohjelma varjasi pisteet harmaaksi.

Import point

cloud

Remove
duplicate points
(Tools->others)

Curvature

Split point
cloud first step
and rest

First step

(tools->others)

(flat areas)

Rest

areas)

Subsample e.g. space

1m neighbours

(curvature ——

Manually remove noise

/ flat areas points

Combine flat
and curvature
point clouds

Kuva 29. CloudCompare—kasittelyprosessi.

6.7.3 Tarkennusaineisto ilman signaaleita

Tarkennusaineiston keraamista kokeiltiin myos ilman signaaleita, jolloin tuloksena on

erilliskoordinaatistossa oleva pistepilvi. Havaittu aineisto sovitettiin pohja-aineistoon ku-

van 30 mukaisesti. Lahteena kaytettiin CloudComparen omaa ohjeistusta [42].

Ensiksi pistepilvet aseteltiin karkeasti |ahekkain, jotta pisteparien ottaminen Align-

tyokalulla oli helpompaa. Sen jalkeen nelja pisteparia otettiin mahdollisimman eri puolilta

aineistoa (kuva 31). Tydkalun avulla suoritettiin ensimmainen orientointi.

Kuvan 32 ty6vaiheessa kaytettiin fine registration -tydkalua. Se on automaattinen ja iteroi

annetusta satunnaisesta pistelukumaarasta Iahimpid mahdollisia pisteita ja tekee niista

pistepareja manuaalisen Align-tyOkalun tapaan. Tyokaluun on mahdollista asettaa

teoreettinen “overlap” -prosenttilukema, joka auttaa laskentaa iteroinnissa. Prosentit

tarkoittavat sita, kuinka paljon pistepilvet menevat paallekkain teoriassa.



45

Tulokseksi saatiin 0.049m virhe, joka vastasi pohja-aineiston tarkkuutta. N&in ollen

rekisterdinti onnistui.

Tuo pisteet ja . e WA e
nime# pilvet Ly \ el e WO ANE 8 e
Rotate/translate ottaaksesi yhteisia f . . .

uudelleen. .. C e . registration Tarkasta virheet ja

" . g . | | tyOkalua pisteita. Pistepareja .. . "
Siivoa pistepilvista . - e —tydkalua korjaa tarvittaessa

tarkennusaineiston tarvitaan vahintaan . -

karkeat hairiot . . lopulliseen parametreja

. . karkeaan kolme, mutta mielellaan " o
pois, esim. . o . . orientoimiseen

. orientoimiseen enemman kuin nelja.
hajapisteet.

| >

Kuva 30. Orientoimisprosessi manuaalisesti.

[ ] [ ] CloudCompare v2.9.1 [64-bit]

X Y z Error
RO 2.54866.. 6.67908.. 34.2182 0.0745466 x
34.1705 0.0633915 | ¥
34.2254 0.0706303 ¥

7 © laser_groun...

(5] DB Tree .
W~ tuotanto_projeKti_... R T = | /| | O| r=20000 | RMS<10% @ C
> laser_ground_g...
(5] X Y z Error ]
> photopilvigroL.
» S M 254866.. 6.67908.. 34.1723 | 0.0633915 X
11 o A2 2.54866.. 6.679%e+.. 34.2161 0.0706303 | ¥
> IR, A3 2.54866.. 6.67908.. 34.0561 00228129 X =
> testi_laserpilve. “o
v v Testi_fine regis... 9 show 'reference’ cloud | ,_ﬂ
7 & photopilvi_g...
i}

)
)
)
>
)
>
3
)
5
>
—

properties . q y
adjust scale Rotation XYz [} E@ATx@Ty @71z

¢

{2 auto update zoom align | | reset | o | | X

5 o Boih clouds (3 least 3 pairs - mig
wially' i nacessary) 4

06 Console

L14:02:55] [8U VIEW 4] VUS avaiianie
[14:62:33] [3D View 4] Shaders available

r4: [3D View 4] GL filters available

[14:52:33] [3D View 4] Color ramp shader loaded successfully
[14:52:33] [3D View 4] Stereo mode: not supported
(14:62:33] [ccGLWindow] 3D view initialized

@b omEmnroRA s+ P D

«

Kuva 31. Align registration manuaalisesti pistepareilla. Esimerkkikuva.
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CloudCompare v2.9.1 [64-bit]
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DB Tree

v v & tuotanto_projekti_20180202_muok.bin (/...
> & laser_ground_gk25_pitkat_tuotanto.la...

» & photopilvi_ground_gk25_pitkat.las (F:/...
» & curvature_erikseen
» & curvature_yhdessa
> & testi_laserpilven matsaaminen photoo...
Properties
Property State/Value
Name laser_ground_gk25_pitkat_tuotant..
Visible v
Show name (in ..
Colors Scalar field ]
X: 68.2888
Box dimensions 9.7838
7:16.628
e Console

[14:12:35] Hint: copy it (CTRL+C) and apply it - o ts inverse - on any entity with the 'Edit > Apply transformation’ tool
[14:12:35] [Register] Scale: fixed (1.0)

[14:12:35] [Register] Theoretical overlap: 20%

[14:12:35] [ICP] Aligned entity global shift has been updated to match the reference: (-2.5486e+7,-6.679¢+6,0) [x1]
[14:12:52] [Apply Applied ion matrix:

[14:12:52] 0.999999126957 0.000086546232 -0.001303847014 0.038298325943

-0.000087221157 0.999999842213 -0.000517598974 0.067628439564

0. 0.000517712304 0. 748 -0.789960317691

o. o 1

o
[14:12:52] Hint: copy it (CTRL+C) and apply it - o its inverse - on any entity with the 'Edit > Apply transformation' tool
:13:08] [ICP][Partial overlap] Selecting 2633125 points out of 8099175 (32%) for registration
13:10] [Register] Final RMS: 0.0460345 (computed on 49999 points)
[14:13:10] [Register] Applied transformation matrix
[14:13:10] 0999999225140 -0.000031736610 0001247358043 -0.039728276432
0.000031114090 0.999999880791 0.000499087386 -0.035102576017

01247373875 -0.000499048154 0.999999105930 0756821453571
0.000000000000 0.000000000000 0.000000000000 1.000000000000
[14:13:10] Hint: copy it (CTRL+C) and apply it - or its inverse - on any entity with the 'Edit > Apply transformation' tool
[14:13:10] [Register] Scale: fixed (1.0)
[14:13:10] [Register] Theoretical overlap: 10%
[14:13:10] [ICP] Aligned entity global shift has been updated to match the reference: (-2.5486e+7,-6.679¢+6,0) [x1]

i

& m %

3D View 1

Kuva 32. Fine registration 10% overlap. Sinisella orientoidut pisteet.
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6.8 Kolmiointi ja valmis 3D-malli

Pistepilvi kolmioitiin kayttdmalld CloudComparen ”"Delaynau 2.5D (Best fit plane)” -ty6-
kalua. Tyokalu kaytti delaunay-kolmiointilaskentaa, jonka keksi alun perin venalainen
Boris Delaunay. [43] CloudComparella pystytaan tekemaan mallin optimointia monella
tavalla laajan parametrien sdatdémahdollisuuden ansiosta. Ohjelman valmiiksi antamat
parametrit osoittautuivat kuitenkin hyviksi, joten valmiiksi laskemia parametreja paatettiin

kayttaa lopullisessa tydssa pelkastaan niita.

Perusideana mallia kevennettdessa on jattaa yksityiskohtaisemmille alueille enemman
kolmioita kuin tasaisemmille alueille. Tall6in resoluutiota pienennettdessa yksityiskohdat
eivat havid kokonaan. Kuvissa 33 ja 34 vertaillaan optimoimatonta ja optimoitua mallia

seka kuvissa 35 ja 36 samoista kohdista rautalankamalleja.
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Kuva 33. Kolmioitu, ei'optimoitu. 7

Kuva 34. Kolmioitu, optimoitu malli.



Kuva 36. Rautalankamalli, optimoitu.
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7 Tulokset ja loppupaatelmat

7.1 Pohdinta

Kevyen 3D-mallin tarkkuus ja resoluutio ovat suhteellisia, ja ne riippuvat paljon
kayttotarkoituksesta. Muun muassa ohjeistuksia luettaessa huomattiin, etta

mallinnuksen vaatimukset on sovittava aina projektikohtaisesti.

Taman insin6orityon tavoitteena oli kehittaa prosessi, jolla tuotetaan kevytta 3D-mallia.
Tavoitteeseen paastin huomioon ottaen tutkimukseen annetut resurssit ja
lahtotasotiedot. Tyon aikana havaittiin, etta tekniikka on ollut jo pitkdan olemassa, mutta
sen kayttéonotto ja tydskentelyprosessit ovat vield kehitteilld. Mallien optimointiin
suoraan liittyvia tutkimuksia ei myoskaan I0ydetty. Tasta tyosta on toivottavasti hyotya

tuotantomenetelmien kehittdjille niin julkisella kuin yksityisellakin sektorilla.

7.2 Tyo6ssa havaittuja nakokulmia ja kokemuksia

Tutkittu aihe sisalsi yhden tarkeimmista tulevaisuuden nakdkulmista liittyen optimointiin
ja mallin rakentamiseen. Samankaltaisia toimintatapoja on hyddyllista ja valttamatonta
tutkia myOs jatkossa. Mallien tuottaminen kasvaa tulevaisuudessa, joten resurssien
vahyydesta johtuen toimintatapojen ja prosessien tulee olla mahdollisimman selkeita ja

hyvin automatisoituja.

Tulevaisuudessa mallin optimointia kannattaa tutkia vielakin laajemmin ja tarkemmin.
Erilaiset teknologiat tarvitsevat jo nyt paljon aineistoa toimiakseen ja sen maara kasvaa.
RPAS-laitteella suoritettavan aineiston keruuseen vaikuttaa akku- ja laiteteknologian
kehittyminen seka uusien toimijoiden maara. Laskentateho ei kuitenkaan kehity samaa
tahtia, joten kompromissit ja optimoinnit tulevat olemaan avainasemassa. Mallintamisen
ja sen tiedostoformaattien standardien muodostuessa 3D-malleja pystytaan
hyddyntamaan entista tehokkaammin ja useammin. Kaikki voidaan mallintaa, mutta se
ei valttamatta ole kustannustehokasta. Oleellinen kysymys tulevaisuudessa on, mika
tieto on hyddyllistéd. On tarkasteltava kokonaisuutta, joka usein ratkaisee lopputuloksen

laadukkuuden.
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Erilaisten menetelmien testaamiseen ja opiskeluun meni paljon tyotunteja, koska aihe oli
opetuksellisesti uusi. Juuri tdma teki aiheesta mielenkiintoisen ja tieto piti etsia
itsendisesti. Tiimitydskentely auttoi asioiden jasentdmisessa ja pohdinnassa paljon.
Koetyon osalta suurin yksittdinen hidastava tekija oli tietotekniikan laskentateho. Se
aiheutti valilla jopa paivien tyhjakayntia. Aineistonkeruupaiviin kannattaa panostaa ja
auditoida siitéa saatava aineisto huolella, koska se vaikuttaa kasittelyn ja lopputuloksen

onnistumiseen.

Koetydn aikana huomattiin, toisaalta myos liian mydhaan, miten tarkeda on suunnitella
ja valmistella huolellisesti se, mita ollaan tekemassa. Taysin tuntematonta aihetta on
vaikea ldhted suunnittelemaan tarkasti, jos ei ole aiempaa kokemusta. Taman tyon
osalta olisi auttanut edeta pienin askelin ja kokoontua sitten pohtimaan, meneekd tyo

haluttuun suuntaan. Maltti on valttia — kuten sanonta kuuluu.

Tiimityoskentely  koettiin ~ onnistuneeksi. = Nykyteknologia mahdollistaa  hyvat
vuorovaikutusmahdollisuudet esimerkiksi kevyen videoneuvottelun muodossa.

Videopuhelut auttoivat keskustelun yllapitdmisessa ja ajatuksien vaihtamisessa.
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